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1. Introduction

This manual describes calibration of photoacoustic gas monitors, which are:

- Innova 1412 Photoacoustic Field Gas-Monitor,
- Briiel & Kjer 1302 Photoacoustic Gas-Monitor.

The main description will be based on the former monitor, Innova 1412 Photoacoustic Field
Gas-Monitor, which is presented on Figure la. The latter monitor, Briiel & Kjer 1302
Photoacoustic Gas-Monitor, see Figure 1b, will be presented in chapter 6 with the explained
differences in calibration procedure. The manual is based on Technical Documentation (1)
and users experience. The manual should be used as a guide line, but in case of any doubts it
is advisable to refer to the Technical Documentation. In some rarely used cases the procedure
is referred directly to Technical Documentation. Some specific or additional procedures will
not be explained in the manual, e.g. the manual does not describe the procedure of checking
fuses, exchanging filters in the Monitor or setting up the filters. Calibration of Multipoint
Sampler and Doser is not considered in this publication. A short description of measurement
procedure is presented in chapter 7.

e -~

° ° ° °

CEEREEELED

a) b)

Figure 1. Innova 1412 Photoacoustic Field Gas-Monitor.

(D)
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2. Preliminary tasks

In this chapter tasks that should be done before turning on the Monitor, as well the calibration
set-up and the Monitor construction are explained.

2.1. Security during calibration

When gas bottles are in the room they are always needed to be safely mounted to a stable
place like wall, heavy not movable table etc. The gas bottles should be move with care, they
should not fall or be damaged during transportation.

Remember that during measurements or calibration concentration of specific gases e.g. CO»,
N>O, SF¢ and acetone should not exceed safety limits.

2.2. Checking and replacing the filters

The monitor is equipped with two filtration units, namely internal and external. The paper
filters inside the filtration units should be changed at least twice a year, however it is
recommended that they are replaced each time before a calibration of the Monitor.

2.2.1. Internal filter

Internal filtration unit is mounted on the air-inlet in the back of the Monitor’s panel, see
Figure 2. Inside there is a paper filter, which removes small particles, like dust before they
reach the measurement chamber of the Monitor. The internal infiltration unit can be easily
removed by unscrewing the unit by hand.

Figure 2. Internal filtration unit.
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To change the paper filter:

- Make sure that the Monitor is not connected to the power.

- Put rubber gloves on hands and unscrew the internal filtration unit from the air-
inlet by turning it anti-clockwise with the fingers.

- Use tweezers to lift the metal ring, see Figure 3.
- Remove old paper filter.

- Using tweezers take a new paper filter from the packaging “Teflon Filter 10 um”
and holding it by its edge place it inside the filtration unit, see Figure 5a. Be aware
not to confuse the filters in the package with the papers which separate them. The
filter colour is white and it is not very transparent, while the papers separating the
filters are more blue and more transparent. If you are still in doubts you can touch
them, the separating paper is more slippery and you can feel some kind of plastic
inside. The picture presenting both filter and the separating paper can be found on
Figure 4.

- Place the metal ring above the new paper filter, make sure that the ring’s locking
tabs fit into the grooves in the unit and gently press the ring, see Figure 5b.

- Place the unit back in the air-inlet of the Monitor and screw it by turning the unit
clockwise with fingers.

b\

Figure 3. Lifting the metal ring by a tweezers.

Filter Paper separating filters

Figure 4. Picture showing filter and the paper separating the filters.
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a) b)

Figure 5. Placing a) new paper filter inside the internal filtration unit and b)
the metal ring above new paper filter.

2.2.2. External filter

External air-filtration unit is an optional accessory, however it is recommended that it is
always attached to the free end of the air-inlet tubing, e.g. in case of performing environment
measurements, see section 3.2. The external unit can be seen on Figure 6. It prevents large
particles and insects from being drawn into the unit, while the paper filter inside protects
smaller particles from entering the tube.

To change the paper filter in the external air-filtration unit pull the unit off the end of the
sampling tube and proceed the same procedure as described in section 2.2.1 for the internal
filter.

Figure 6. Picture showing external filter.
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2.3. Monitors construction

The measuring principle is based on Infrared Photo Acoustic Spectroscopy (PAS) and scheme
of the monitor can be seen on Figure 7. The main parts are namely infra-red source, optical
filters carousel with six positions, microphone in measuring chamber, pump, air inlet and air
outlet. The Monitors base measurements on a precise microphone and because of this the
monitors should be placed on stable location during calibration and measurements.

Air Outlet

Chopper Wheel Optical Filter Carousel

Parabolic Optical Microphone 2 )
Mirror V\ﬁ?\dow P Air-shunt
Pump |
Shunt Valve
Qutlet
Valve '
Iy I
(X)) Pressure Sensor
18 Flush vaive

Inlet
Valve

E; = Internal Fine Air-filter

Coarse

Infra-Red Temperature : External Fine e
Source sensor Microphone 1 Airfilter Air-filter
Optical Filter H/
Measurement ! |
Chamber - " <:
Sampling Tube |
Ping L‘ Air Inlet

Figure 7. Scheme of the monitor construction. (2)

2.4. Calibration set-up
2.4.1. General calibration set-up

The scheme of general equipment needed to perform the calibration is shown on Figure 8.
Three Teflon tubes are connected with each other by a “Y”-piece, exemplary Teflon tubing
can be seen on Figure 11. The tube attached to point 1 is connected to the air-inlet of the
Monitor, tube connected to point 2 is attached to a gas flow meter and the tube connected to
point 3 is attached to the gas cylinder, which is used during the calibration. It is recommended
that the Teflon tubing attached to the air-inlet should be maximum 50 m length.
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Pressure
gauges

To

To flow meter
Teflon Lo el

tubing /

Gas flow

Attachment

point no.2 'Y" - piece

gas -f——

stpl_\' /

y Teflon
Gas - supply tubing
cylinder

Attachment

An ichment

point no.1
Teflon tubing
R i connected to
air-inlet of
the monitor

point no.3 == @
. - ee s e |

Monitor

/

893264 le

Figure 8. Scheme of general equipment required for a calibration task. (1)

When performing calibration with one of the filters: UA0983, UA0984, UA0985, e.g. carbon
dioxide (CO3), carbon monoxide (CO), dinitrogen oxide (N»O) additional tubing, called
Nafion tubing is required. Picture showing Nafion tubing can be found below, see Figure 9.
The Nafion tubing should be connected by tube-fittings to the Teflon tubing between the
“Y”—piece and the gas cylinder, see Figure 10 and Figure 11. Do not place it between the

“Y”—piece and the Monitor due to higher gas usage.

Figure 9. Nafion tubing.
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Tefl To flow meter
Pressure eflon

gauges rubmg \ /
Tube — fittings /

Gas flow
Attachment .
\ Poim no.2 / n"y" piece

* = Attachment
point no.1
Teflon tubing
connected to
Teflon Nafion Teflon air-inlet of
Gas - supply tubing tubing tubing the monitor
cylinder Attachment

point no.3

Monitor

900871 _le

Figure 10. Scheme of equipment required for a calibration task with the Nafion
tubing attached. (1)

Nafion tubing

——

Teflon tubing

Figure 11. Nafion tubing and “Y”-piece connection.

The flow meter can be seen on Figure 12 and it has two functions in the set-up:

- there should be a net flow out of the Teflon tube attached to the flow meter during
the whole calibration procedure and the flow meter allows to check it. When the
gas pressure out of the gas cylinder is too low the “flow ball” is seated on the
bottom of the flow meter. This can decrease the accuracy of the calibration,
because the air can be drawn into the Teflon tubing through the flow meter and
dilute the calibration gas.

N.B. The “flow ball” should never be seated on the bottom of the flow meter. It is
important to set the flow to the lowest possible value to decrease use of the
calibration gas, but also the flow should be observed during calibration especially
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when the pump in the Monitor is working. The pump creates under-pressure and it
can lower the “flow ball” position.

- it functions as an escape valve, when the pressure in the tubing becomes greater
than the atmospheric pressure, the gas flows out through the gas meter. This
ensures that the gas entering the analysis cell has always pressure close to the
atmospheric one. It is very important that the gas entering the analysis cell has
pressure not higher than 0.1 bar above the atmospheric pressure, because of very
sensitive microphones inside the monitor. It is never allowed to connect the air-
inlet of the monitor directly to the pressure valve of the gas cylinder.

Air-outlet

—> 0, —»
-

—————» To atmosphere

to flow

"Y" piece .7
_—> g : _~ Air-inlet
from gas cylinder :
\ To the monitor

RO3266 le

a) b)

Figure 12. Pictures showing flow meter a) scheme of flow meter’s connection b)
real flow meter. (1)

The air-outlet tubing of the flow meter should be long enough, so that the sampled gas is
carried away to the open air. The same is required from the air-outlet tubing of the Monitor.
On Figure 13 can be seen Monitor’s back panel with highlighted air-outlet.

Air-outlet
-)

Figure 13. Monitor’s back panel with highlighted air-outlet.
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An exemplary picture of the real calibration set-up can be seen on Figure 14.

Figure 14. Exemplary calibration set-up.

2.4.2. Calibration set-up for humidity calibration

When performing a humidity calibration clean, wet gas is required. This can be obtained in
the way described below.

A zero-gas, e.g. pure nitrogen (Nz) is bubbled through a thermostatically controlled water
bath, scheme of the set-up can be seen on Figure 15 and the real set-up is showed on Figure
16. Besides the water bath in the set-up can be seen second empty flask which acts as a safety
valve, it prevents from a situation in which the water rises in the water bath and fill in the
tubing connected to the “Y”-piece and further flows directly to the analysis cell of the
monitor, which may seriously damage the Monitor. The same function as the empty flask can
have a separation filter, which is shown on Figure 18. On Figure 16 between the gas supply
and the water bath can be seen additional Nafion tubing, however this accessory is not
necessary in the humidity calibration and the gas supply and water bath can be connected
directly by a Telfon tubing.
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water 3 / To flow

> vapour outlet tube “B"\ V/, ' e,

from zero-gas supply Y" picce
& outlet tube "A"
To the
/ < monitor

L

N

AR
\/\\4\

XX
AN

B N

water ata > empty -
constant / flask /
temperature S s A loactasa Ao A S

safety valve

Figure 15. Scheme of obtaining clean, wet gas through a water bath.

Precition termometer

Empty flask® ~

/'/’—" a—- ” ==
Water bath !
, ~——

Figure 16. Set-up for humidity calibration.
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Following steps should be performed to obtain a humidity calibration set-up:

- A special water bath, see Figure 17a, is filled with demineralised water. There
should be enough water inside the bath, so that the bath’s inlet tube is covered by
water, but the outlet tube is above the water level. The distance between outlet and
water should be large enough not to suck water from generated bubbles.

- The water bath is carefully placed into an ISOCAL 6 equipment and the Teflon
tubing is connected to inlet and outlet of the water bath, see Figure 17b.

- The separation filter shown on Figure 18a, which functions as an empty flask, is
mounted between the water bath and the “Y”-piece, see Figure 18b.

b)

Figure 17. Pictures of a) water bath and b) water bath with precision thermometer
placed into ISOCAL 6 and connected with Teflon tubing.
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a) b)

Figure 18. Pictures showing a) The, functioning as an empty flask, b) connection
of the separation filter as “empty flask” to a Teflon tubing.

It should be noted that it is very important to obtain water vapour, which concentration is
below the saturated water-vapour pressure of the ambient air. In other case the water vapour
can condense in the analysis cell. In practice it means that:

- The Monitor must have time to be warmed up or reach the ambient temperature of
the room, before the calibration is started.

- The temperature of the water bath must be at least 2°C below the ambient
temperature (for example if the ambient temperature is 20°C, the temperature of the
water bath can be maximum 18°C). For most of the cases water temperature of
15°C set in ISOCAL 6 is low enough and exemplary calculations of water
concentration, which has to be typed in the software during calibration, are shown
in section 4.3. The temperature used in calculations should be measured by
precision thermometer.
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3. Tasks before calibration

Before starting the calibration it is advised to perform the necessary preliminary tasks, see
chapter 1. The computer with installed Gas Monitoring Software 7304 for the Monitor should
be turned on. After Windows started up the Monitor can be turn on at the mains. It should also
be noted that the Monitor should be keep for some time in room temperature before starting if
it was brought from cold environment.

A problem with power supply for the Monitor might mean that the fuses in the monitor are
broken. For checking or changing the fuses in the Monitor it is advisable to follow section
2.3 Checking /changing the Fuses in the Monitor in Technical Documentation (1).

3.1.Starting the software for the monitor

When the Monitor is ready to use the software can be opened. It should be possible to find the
icon on the desktop of the computer, see Figure 19a, as well as the connection information for
Innova 1412 and Briiel & Kjeer 1302 Gas Monitors presented on Figure 19b and Figure 19¢

respectively.

Innova 1412 Briiel & Kjzer 1302
9600 9600

& & Even None
1 2
7 8

2| [18) =10 () # Leased line Three-wire
Hardwired X-on/x-off

a) b) c)

Figure 19. Pictures of a) software’s icon for calibration and communication
configuration for b) Innova 1412 and c) Briiel & Kjar 1302 Gas Monitors located
on the desktop of the computer.

- Start the Calibration Software. The window Communication should apear, see
Figure 20a.

- Select the correct port, which is used to communicate with the Monitor (usualy
COM1), and check that the communication parameters are consistent with the ones
presented on Figure 19b and click OK.

- Select New Calibration Task L (Task > New) and type in the description of the
calibration task, see Figure 20b, and click OK. If you want to use an existing task

then click on Open = (Task = Open), highlight the desired name and click OK.

- A new window should appear, which means that file is ready to be used for
calibration, see Figure 21a.
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- It is advised to check units which the monitor is using before starting calibration.
The units can be found in Task menu. Pull down the Task menu, click on Units
(Task - Units) and examine the Units dialogue that is displayed, see Figure 21b.
The monitor measures raw data (uV), so these units do not affect the display data
for the calibration (uV), but for example input values.

N.B. It is advisable to set the gas concentration unit to the same that manufacturer
uses on gas bottles. Often it is parts per million (ppm). Also it can be useful to set
water vapour concentration to absolute humidity (mg/m?). As a result no additional
recalculation will be needed.

—Com Port
& COM1: " COM2:
" COM3: " COM4:
— Gas Monitor Communication Setup
Baud Rate: 9600
Stop Bits: 1
Data Bits: 7
Parity Check: Even
Hardwire Mode: Leased-Line
Handshake Type: Hard-Wired
Text Line Terminator: CR-LF i |

a)

X
Enter description:
| Test Calibratior| 0K |
Gas Monitor Serial: 710164 Cancel |

b)

Figure 20. Software dialogue for a) communication and b) task description.

|- Calibration - Test Calibration

Task Sequence YValues Bank Edt View Window About

Dis| | & Pl (] «] F8| 5] Sl sl 6] F e

— A Carbon dioxide (uV)
— B: Dinitrogen oxide (V)
— W Water Vapour (UV)

@ Graphic Window 1

=
— T: Temnperature (°C)

a)

units x|
[~ Detault Units
Humidity:  Pressure: Temperature:  Gas Conc: Length:
g/ mBar K C gim ® m
C mg/m? C mmHg & °C  ma/m? C it
C pg/m? O kPa ¥ B " pg/m?
C vol%x C hPa  vol%
C ppm  ppm
 ppb C ppb
 Tdew
 kPa
C Pa

1~ Normalization Temperature

2T vI

i 0°C J
;ZS < _

Cancel |

b)

Figure 21. Picture of software’s dialogues: a) starting dialogue — window
appearing before starting calibration and b) units dialogue.
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3.2. Warming up the Monitor

Before starting the calibration task it is advisable to warm up the Monitor to decrease
measurement time and gas usage. In the Monitor it is possible to set-up Continuous Warm
System to ensure that the Monitor is kept warm, when the monitor is not measuring. The
function becomes active after Partial Reset, Power up or stop of Measurement. The Monitor
can be set-up also by using its front panel, which can be seen on Figure 22. In practise it
means that you need to proceed:

- Click Set-Up button on the front panel and select Configuration, next System, later
General and Tests settings (Set-Up =>S3 > S1 2S51).

- Find Continuous Warm System using arrows on the front panel (¥ >V = V) and
click Yes (S3).

- The warming up will start after Partial Reset, Power up or stop of Measurement.
Partial Reset can be selected in Reset menu from the front panel (Reset = S2).

r@ INNOVA 1412 Photoacoustic Field Gas-Monitor

Aur lech Instruments

ACTIVE TASK: MONITORING TASK NUMBER 1

o
TALK START TASK DELAYED START CHANGE TRSK

2= S3 ASetUp

© -
© DO 2680 ..

Figure 22. Front panel of the Monitor.

Another possibility to start warming up is by setting an environment measurement. In this
case the temperature of the Monitor can be observed. The inlet to the monitor instead of
connecting to the gas supply should be left in the laboratory. The free end of the sampling
tube should be attached to external filter, see section 2.2.2 External filter.

- Prepare the software for the calibration, see section 3.1 Starting the software for the
monitor. Warming up the Monitor can be conducted in separate file so it will not
confuse user during calibration procedure.

- Pull down the Sequence menu and select Settings (Sequence —> Settings).
- In Calibration index card select Zero Point Calibration (All filters), see Figure 23a.

- In Gas index card click Reload Filter Info, see Figure 23b. This can take a moment,
so wait until it has finished before continuing.
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- In Sampling index card select Fixed Time Flushing and choose flushing times,
which can be 8 s for chamber and 3 s for tube, see Figure 23c. Click OK.

- Start measurements *| (or Sequence =>Start) and wait until the temperature will
reach around 40-45 °C, see Figure 24.

- Stop the measurements |2 (or Sequence =>Stop) and prepare next step of the
measurements. In case of temperature drop in the Monitor repeat warming up due
to temperature decrease of the Monitor.

Calibration lGas | Sampling | Calibration Gas |Sampling| Calibration | Gas ~ Sampling I
Calibration Type————————————— ~ Current Air Pressure— ~ Filter Setup for Calibration Value: Flushing
& Zero Point Calibration (A1l Filters) Gas Name: Mol Wgt: . Auto:
€ Humidity Calibration 98775 hPa A UADss2  1: ICalbun dioxide =l |44.01 Tube Length: E 4 m
" Gas Span Calibration B: UAD3SS 1 IDinillogen oxide j IMD‘I te. Fized Time:
C: nfa 1: |7 L] Iw o0 Chamber: E—B s
D: nfa 1 = I‘UJE\ Lt E—3 i
E: nfa 1 =l IW 00
W: SBO527  1: ‘Water Vapour 18.02
— Sample Integration Time (S.1.T)
[Nemal5s) =] ReloadFiter Info |
[TI Cancel Default. ’TI Cancel | Default. 'I
a) b) c)

Figure 23. Sequence Settings index cards for a) Calibration, b) Gas and
c) Sampling.

— A: Carbon dioxide (uV) — T: Temperature (°C)
— W: Water Vapour (uV)
- 50
1000 - 45
750 -
- 40
500 -
4 - 135
250 - T
- 30

25 50 75 100 125 150 175

Figure 24. Data for the measurements during warming up the Monitor
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4. Calibration

For a new calibration procedure it is advisable to create a new file, which will be used for the
whole process of calibration and for all the gases. Setting-up the new file is described in
section 3.1 Starting the software for the monitor.

The calibration should be proceeded after the Monitor is warmed up. Warming up the Monitor
is described in section 3.2 Warming up the Monitor. Procedure of calibration can be seen on
Figure 25 presenting simplified algorithm.

Warming up

N> gas: Zero point calibration

N2 gas with water bath: Humidity calibration

CO; gas or/and N>O gas or/and other:
Gas span calibration

Calibration factors calculation and download

Figure 25. Simplified calibration algorithm.
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4.1. Calibration Factors

The Monitor is using Calibration Factors to calculate concentration of specific gases in the
gases mixture. The calculation of gas concentration based on linear curve approximation is
presented on Figure 26. The zero-point calibration is needed to find offset point for the
calculation (point A on the figure). The span calibration for different gases and water vapour
(point B on the figure) is needed to find the angle of the span calibration line, which is
expressed by span calibration conversion factor.

Humidity gain
factor correction

Single-point Span Calibration of Filter "A"

vV -V
total H?_O)

f

Total

signal

in the
cell

Vol'fsct

Zero-point calibration

Gas Concentration —_—

Figure 26. Graph showing gas concentration calculation. (1)

It should be noted that for each filter there are five banks available. Banks are memory
location for calibration factors. Default location of the calibration is bank number 1, but the
other banks can be used for instance when one filter is used for measuring two gases, so bank
number 2 will carry the information about second gas.

Each of the calibration is made for specific gas for the selected filter. There are five slots for
filters, named from A to E, and additional for water vapour, named W. Filters have different
properties and can be used only for specific gases, see Poster: Gas Detection Limits (3).
According to Technical Review (4), when selecting one optical filter for monitoring a single
gas, the following should be considered:
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- The detection limit or, alternatively, the sensitivity factor,
- Interference from atmospheric water vapour and carbon dioxide,

- Interference from other gases likely to be present in the monitoring environment,
including some common trace gases.

Due to interference of the water vapour on all the filters and appearance in the measuring
conditions the correction for the water vapour is needed. The correction is made by humidity
gain factor and it should be calculated for all the filters. The correction for the cross-
interference is needed, if in the measured sample except measured gas there is another gas
that meets one of the two conditions:

- Other gas has high influence on the filter that is used. This means that a large part
of the signal will be affected by the interference, which will decrease accuracy and
change the result.

- Other gas has small influence on the filter that is used, but the amount of the gas in
the sample can change. This means that the accuracy of the measurement will be
strongly affected and the result can be incorrect.

So the filter can be used for the chosen gas without cross-interference calibration only, when
other gases in the samples have small or preferable no influence on the signal and have stable
concentration. In other case the same correction as for the water vapour should be made if the
result on one filter can be affected by other gases. Cross-interference calibration factor
purpose is to correct the result for influence of other measured gases.

Installed filters type and their location as well as an exemplary gas that they can measure and
the gases cross interference on the other filters can be seen in Table 1. Additional information
about possible gases that can be measured can be found in Poster: Gas Detection Limits (3).
Cross interference information can be found in actual Service Report.

Table 1. Filters type and their location with exemplary gas that they can measure and
the gases cross interference on the other filters.

Filter Gas Installed? * Cross interference on other filters? *
(location, (name, Innova | B. & K.
type) molecular) 1412 1302 A B C D
A Dinitrogen oxide,
UA0985 N2O * * - * *
B Carbon dioxide,
UA0982 CO, i " i B i
C Aceton
’ - + + + +
UA0970 C;HsO
D Sulphur Hexaflouride,
- + + - +
UA0988 SFs
E empty — — — — — —
W Water vapour, H.O + + + + + +

*) Plus (+) means “yes” and minus (-) means “no”.
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4.2. General settings

In this section steps which are common in different calibration types will be explained. The
calibration should be proceeded only when the correct set-up is prepared.

- Pull down the Sequence menu and select Settings (Sequence > Settings)

- In Calibration index card click on the radio-button * to select the desired
calibration type. The individual sections below explain details about different
calibration type. The exemplary Calibration index card can be seen in Figure 23a.

- In Gas index card click Reload Filter Info if you have not uploaded it before. This
can take a moment, so wait until it has finished before continuing. Check the filter,
gas names and molecular weight information. If you are only recalibrating the
Monitor for the same filter positions and memory banks, then the names of the
gases will be probably correct.

If you are calibrating a new gas or an existing gas in a new filter bank, then the
name of the gas and the molecular weight need to be typed in. This can be done in
the Gas card and details are described in Technical Documentation (1) in section
14.11.1 Setting-up a Span Calibration- PC Use. Before changing these information
contact person responsible for the Monitor. More information about filter banks can
be found in Technical Documentation (1) in section 14.6.1 Retaining Existing
Calibration Factors.

Click in the Sample Integration Time (S.1.T.) field, and select the desired time. For
standard usage Normal (5 s) time is enough.

N.B. The S.I.T. value should be set to the same as those which are planned to be used
later for monitoring. Higher S.I.T. increases precision and measuring time, see e.g.
Poster: Gas Detection Limits (2).

In Sampling index card select the desired Flushing Type.

N.B. the Flushing type and values should be set to the same as those used when
monitoring

- Select Fixed Time Flushing and choose flushing times, which can be for instance 8
s for chamber and 3 s for tube, see Figure 23c¢. Click OK.

- After these steps the settings for calibration should be prepared and the calibration
measurements can be started. To start the measurements click Start measurements
2| (or Sequence =»Start). The measurements should continue until the results are
stable.

- Stop the measurements L=l (or Sequence = Stop).

The calibration should be repeated for all the gases and the next step for calculation of
coefficients is described in chapter 5 Calibration Factors Calculation.
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4.3. Zero point (N2)

In the zero-point calibration for all the filters zero-gas is supplied for instance pure nitrogen
(~100% N3). The set-up and procedure is described in preceding section. The zero-point
calibration should always be performed for all the filters.

N.B. The zero point calibration requires humidity gain factors stored for the filters
that are going to be calibrated.

This means that:

a) Ifyou have already stored humidity gain factors for the filters:

- You can use them when performing zero point calibration.

- Or you can perform humidity-interference calibration in Humidity Calibration, see
Figure 27, in the same Calibration Task. A new humidity gain factors can be
calculated at the end of calibration, which is explained in section 5.2 Calculating
and downloading.

b) If the humidity gain factors are not stored for the filters from previous calibrations, e.g.

the filters are going to be used for the first time:

- You have to perform humidity-interference calibration in Humidity, see Figure 27,
in the same Calibration Task. The humidity-interference can be performed together
with water-vapour span calibration. A new humidity gain factors can be calculated
at the end of calibration, which is explained in section 5.2 Calculating and
downloading.

4.4. Humidity calibration (H20)

The gas supply required during the humidity calibration is a clean, wet gas supply, the set-up
and the procedure of obtaining the gas is described in section 2.4.2 Calibration set-up for
humidity calibration.

The water-vapour filter has two different functions:

- The most important function is to enable any other signal to be compensated for the
water-vapour interference.

- Its second function is to measure absolute water-vapour concentration in the
samples. To be able to do this, the filter has to be additionally span calibrated.

When the Humidity Calibration button is selected, see section 4.2 General settings, two check
boxes will appear in the Calibration Parameters field, see Figure 27. The button Perform
Water Vapour Span Calibration needs to be selected if the absolute water-vapour
concentration in the samples needs to be measured. In this case it is necessary to enter the
water concentration in the gas which is used, details of the water concentration calculations
are explained in section 4.4.1 Water concentration calculation. Button Humidity Interference
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Calibration needs to be selected both if we want to perform water-vapour interference
compensation. Although interference calibration is performed on all of the filters, it is
possible to choose, which filters will receive the humidity gain factor, when the calibration
factors are calculated and downloaded, see section 5.2 Calculating and downloading.

Calibration Sequence Settings (Sequence 4) x|
Calibration I Gas ] Sampling]

— Calibration Typg———————————————— [~ Current Air Pressure——
" Zero Point Calibration (&l Filters)

988.75 hPa

% Humidity Calibration

" Gas Span Calibration

— Calibration P
[V Perform \Water Vapour Span Calibration (Water Filter):

Water Concentration: E_ b2 a/n

¥ Humidity Interference Calibration [All Filters)

0K I Cancel | Default... |

Figure 27. Sequence Settings index cards for Humidity Calibration.

4.4.1. Water concentration calculation

The water vapour should be calculated for temperature of the water bath. Calculation of
vapour amount in the gas can be found in Excel spread sheet Water Vapour Calculation.xlsx.
Exemplary calculation formulas for absolute humidity and vapour pressure are presented
below in equation 1 and 2, respectively. The equations are based on (5) and (6).

AH = 2.1672H22 (eq. 1)
t
7.45t
Pr,0 = 610 - 10253+t (eq.2)
AH Absolute humidity [g/m?]
PH,0 Vapour pressure [Pa]
t Temperature of water bath [°C]
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4.5. Gas span calibration

During the span calibration a supply of particular gas (here CO> and N>O used as an example)
of known concentration is attached to the air-inlet of the Monitor. Before the span calibration,
the zero-point and humidity-interference calibrations of the filter must be performed. For the
span calibration the signal is measured using the filter, which is being calibrated and the
water-vapour filter, which means that the total signal of the calibrated filter can be later
compensated for any signal produced by water-vapour’s absorption of light.

The span calibration can be performed in two ways depending on how linear is the
relationship between gas’s concentration and a signal it produces :

- Normal precision: One-Point Calibration — should be used, when the
measurements are within the linear range. In practice for the most common gases,
the linear range is between the gas’s detection limit and up to 10 000 times the
detection limit,

- Special precision: Two-Point Calibration — should be used in the non-linear range
and when the measurements are over a dynamic range of 100 000, which means
that the maximum measured value is 100 000 larger than the smallest. More details
about determining the linearity can be found in Technical Documentation (1) in
section /4.11 Span Calibration.

In this manual only the one-point calibration is described as it is the most common one. When
a one-point calibration is performed the concentration of span gas should be at least 100 times
its detection limit and preferably not higher than the highest concentration which is supposed
to be measured. The detection limit for example for CO> is equal to 1.5 ppm and for N>O is

0.03 ppm. An exemplary values for concentration range and calibration gas can be found in
Table 2.

Table 2. Exemplary concentration range and details for CO2 and N>O

T One-Point Calibration Calibration gas
Detection limits . )
Gas name measuring range concentration
[ppm] [ppm] [ppm] [-]
75% - 100% of
CO; 1.5 1.5 to ~15000 > 150 the highest
concentration
N0 0.03 0.03 to ~300 >3 | expected to
measure
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4.5.1. Cross-interference calibration

If any measured gas is absorbed by more than one of the installed optical filters, then it is
advised to perform the cross-interference calibration. This provides the information, how
large is the signal that is caused by other calibrated gases, and subtracts it from the result. This
gives the real concentration not affected by interfering gases. The details about interference of
different gases can be found in Poster: Gas Detection Limits, (2) or (3). In this way during the
span calibration the signal is measured not only by the filter, which is being span calibrated
and the water-vapour filter, but also by the other installed optical filters. Cross-interference
calibration decreases the effect of other gases concentration or variation for the gas
measurements on selected optical filter. It should be noted that the cross-interference
calibration cannot be performed alone and always has to be followed by the span calibration.

4.5.2. Setting-up the span calibration

When the Gas Span Calibration button is selected, see section 4.2 General settings, the
Calibration Parameters field will appear as shown on Figure 28.

If you perform a single-point calibration, then make sure that the Perform Two-Point
Calibration button is not selected, enter the concentration of gas that will be measured and if
the cross-interference calibration is necessary, then select the button Perform Cross
Interference Calibration. If you want to perform two-point calibration, then look at the details
in Technical Documentation (1) in section 14.11.1 Setting-up a Span Calibration- PC Use.

N.B. The span calibration has to be performed for each filter individually, therefore this
procedure has to be repeated for each gas that you want to calibrate.

Calibration Sequence Settings {Sequence 4) x| Calibration Sequence Settings (Sequence 4) X
Calibration | Gas | Sampling| Calibration | Gas | Sampling|
~ Calibration Type Current Air Pressure—— - Calibration Type Current Air Pressure ——
" Zero Point Calibration (4 Filters) " Zero Point Calibration (&l Filters)
€ Humidity Calibration 988.75 hPa " Humidity Calibration 988.75 hPa
¢ [Gas Span Calibration ' Gas Span Calibration
— Calibration P b — Calibration P
Active Filter: IA: Carbon dioxide L] Active Filter: IB: Dinitrogen oxide El
™ Perform Two-Point Calibration I~ Perform Two-Point Calibration
Gas Concentration: E. ppm Gas Concentration: E_ WF# ppm
[V Perform Cross Interference Calibration [V Perform Cross Interference Calibration
oK I Cancel Default... oK I Cancel Default...
a) b)

Figure 28. Gas span calibration Sequence Settings: Calibration Parameters a) CO2 b) N>O.
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5. Calibration Factors Calculation

After all the measurements for calibration are finished the spans for stable results can be
selected and calibration factors can be calculated.

5.1. Span selection

After the Calibration Task is finished the spans of stable results can be found. If there is more
than one calibration done in the Task the graph can be cut for the better view of specified
time:

- Pull down the Edit menu and click on graph Window Properties (or Edit >
Window Properties)

- In Interval index card in Measurement Sequence box select specific interval, see
Figure 29a, where Sequence I means first measurement done between Start and
Stop in the whole Calibration Task for instance warming up. Click OK and the
specified interval will be selected.

- To choose span for stable results in Window menu click Cursor Values x| and
click on the graph and select result span for stable conditions (Window = Cursor
Values). Mean, minimum, maximum and standard deviation values are presented in
Cursor Values dialogue, see Figure 29b, and can be used to locate suitable range of
data.

- To select span for stable results in the Sequence menu click Mark Interval El
(Sequence > Mark Interval). An exemplary graph window with selected interval
can be seen on Figure 30a.

- All the calibration intervals for calibration factors calculation should be selected
and an exemplary final graph can be seen on Figure 30b.

The shortcuts used on the graph represent:

- ZP is zero-point calibration

- HS is humidity span calibration

- HI is humidity interference calibration

- HIS is humidity interference and span calibration

- SHA is a Single point or Span calibration for filter A (SHB is for filter B etc.)
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[Graph Window Properties 5[

Interval ILeft Y-axis | Right Y-asis |

Sequence 2
Sequence 3 52

Date: E 120328 Date: l::,l 12-03-28

Time: E 133021 Time: E} 15.48.17

M Number
From: To:
Number: |- 249 Number: |- 463
@ Cursor Values [Graphic Window 1]
Left Cursor: 106 Right Cursor: 131 No. of Samples: 26
Minimum Average Maximum Std. Dev.
Carbon monoxide (ppm) -0.210 0.033 0.350 0124
Cancel TVOC ref. Methane (ppm) 2151 2300 2525 011
Water Vapour (Tdew °C) 6.084 6.276 6.537 0.097
a) b)

Figure 29. a) Graph Window Properties index card for Interval and b) Cursor
Values Window. (1)

— A: Carbon dioxide (V) — T: Temperature (°C) — A: Carbon dioxide (V) — T: Temperature (°C)
— B: Dinitrogen oxide (uV) — B: Dinitrogen oxide (V)

— W: Water Vapour (V) - » — W: Water Vapour (uV)

300 49.50 P zZP HIHIS SBBB SHBHA,
R r 50
275 |\ 49.25 1000 [\ \
250 49.00 . I : \ L 45
205 48.75
48.50 750
200 48‘25 F40
175 48-00
- 35
i s 50
100 pibis i 30
75 y 250 1\
47.00 \ ’ ‘ L 25
50 46.75 : \ . .
251 46.50 ) R S S Y
50 100 150 200 250 300 350 400 450 500 550 600 650

Figure 30. An exemplary graph window with interval selected for calculation for
a) zero-point calibration and b) all the calibrations.

5.2. Calculating and downloading

After all the desired spans are selected the Calibration Factors can be calculated and
downloaded to the Monitor.

- Pull down the Values menu and click on Calculate @ (Values = Calculate...).
When calculations are finished the Calculation Finished dialogue is displayed, see
Figure 31a. The window informs which Calibration Factors have been calculated
and this depends only on the selected curves in Calibration Task Graphic Window

and not on what measurements were performed. Investigate the window and click
OK.
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- The Calibration Factors are ready to be downloaded to the Monitor. Pull down the
Values menu and click on Download (Values = Download...). The Download
window, see Figure 31b, will open and the correct Calibration Factors should be
selected in each index card. Investigate the check boxes in the window and click

OK.
Zero Point IHumidity Interference] Gas l
-~ Download Values To Banks
o
Calculated Values 1 1 2 3 4 5
i A: Carbon monoxide E] D D D D
Humidity:
(] Water Vapour Span B:TVOCrefMethane ] 7] ] ] I
Humidity Interference (4ll Gas Filters) C:n/a ECEEOEFE
Gas Span:
Single-point  Two-point  Cross Int. D:n/a F (S R s B
A; Carbon monoxide ] ] O E: n/a EFiE E E E
B: TVOC ref. Methane ]
C: n/a | Il [ W Water Vapour E]
D: n/a ] ] ]
T ] O] O Unselectll | Selectall |

0K I Cancel I Ed'tVaiues...l
a) b)

Figure 31. Dialogue windows for a) Calculation Finished and b) Download.

In the Download window there can be four possible looks of check boxes:

- I' The white boxes represent filter banks containing no calibration factors — you
can freely enter calibration factors here without losing any existing information.

- T The white boxes with a red shadow already contain calibration factors — you can
download the new factors to these filter banks, but the existing information will be

lost.

- ¥ The ticked check boxes with a black shadow are the computers suggestion as to
where the new calibration factors should be downloaded — it is normally these
positions you would select when performing a recalibration of the Monitor.
However, you are free to remove the tick from the check box and place it else-
where, or place more than one tick for a filter. Several ticks enables calibration
factors to be downloaded to several banks for the same filter.

- I The grey boxes — these filter banks are not available — therefore no calibration
factors can be downloaded here.
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6. Briiel & Kjer 1302 Photoacoustic Gas-Monitor

In this chapter the calibration procedure of Briiel & Kjeer 1302 Photoacoustic Gas-Monitor
will be explained. It should be noted that mainly the differences between this Monitor and the
Innova 1412 Photoacoustic Field Gas-Monitor calibration are going to be presented, so it is
necessary to be familiar with the previous parts of the manual to be able to perform the
calibration. The main difference between these two Monitors is that during calibration of the
Innova Monitor the calibration software is used, while to calibrate Briiel & Kjar only buttons
on the front panel of the Monitor are used. The Briiel & Kjceer 1302 Monitor can be seen on
Figure 32. This chapter is based on Instruction Manual (7).

Figure 32. Briiel & Kjaer 1302 Photoacoustic Gas-Monitor.

6.1. Tasks before calibration
6.1.1. Set-up Tree

For the Briiel & Kjeer 1302 Monitor a calibration is performed on the Monitor’s front panel,
which is presented on Figure 32. Some of the calibration tasks can be found in the menu
which can be presented as a set-up “Tree”. To access the menu click Set-Up button on the
front panel, when Monitor is ready to use. There are three main branches of Set-Up “Tree”,
which are shown on Figure 33.

[ Press “Set-Up” .J

-
\J v Y

Measurement Format Configuration

Figure 33. Main branches of the 1302 Monitor’s Set-up “Tree”.
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- The extended Measurement branch can be seen on Figure 34a. The branch is used
to perform the monitoring tasks. It can also be used to warm up the Monitor, which
is described in section 5.1.2.

- The extended Format branch can be seen on Figure 34a . It is used for plotting the
results and is not a part of this manual.

- The extended Configuration branch can be seen on Figure 35 and it is used to set-
up the Monitor’s parameters. The Unit and Filter parts are described in section

MEASUREMENT FORMAT
l Enter Averaging Period
Monitoring Task Environment
. Print and/or Plot Each Gas
Enter Monitoring Task Set-up Number YES
|
Sample Continuously ? Print/Plot Gas A:.......c.c.e.. ?
“YES" Enter Length of Sampling Tube
9 Print/Plot Gas B:............... ?
Enter Sampling Interval Print/Plot Gas C:............... ?
Monitor for a Pre-set Period ? Print/Plot Gas D:.......ccc..... ?
“NO” J
Enter Monltc;rtng Period Enter Actual Air Pressure Print/Plot Gas E:......ccceuue.e ?
Print/Plot Water Vapour?
Compensate for Water Vap. Interference ?

Enter Normalization Temperature
Compensate for Cross Interference ? Select Concentration Axis Type

Measure Gas A ... ? Enter Pen Speed

l Returns to | o
Measure Gai B:ureerreeeenns ? Previous Head Select Pklmer Type

Select Plotter Paper Feed

Measure Gas C:....ccceueunens ?
Select Text Line Terminator
1
M e GasD: ? Returns to
Previous Head
Measure Gas E:....cceeenne ?

Measure Water Vapour ?

Returns to
Previous Head

a) b)

Figure 34. The Set-Up “Tree” for a) Measurement and b) Format branches. (7)
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6.1.2. Warming up
To warm up the Monitor you can set-up environment measurements:

- Start the monitor and wait until it displays “Monitor is ready to use”.

- Click Set-Up button on the front panel and select Measurement and later
Monitoring task (Set-Up 2>S1 2>SI).

- Edit the monitoring task in the following way (S2-2>S3-2>S1>S1->S1)

- Press SI until the text “Measure water vapour?” is shown on the display. Click Yes
(83).

- Select Environment in measurement Set-up branch (S53).

- Enter length of sampling tube and accept (S2).

- Enter actual air pressure and accept (S2),

- and normalization temperature and accept (S2).

- Click Set-Up button on front panel to exit menu (Sez-Up).

- Click Measurement button on the front panel, later Monitoring and Start Task
(Measurement > S1 2>S1).

- The monitor will now measure continuously water vapour in the environment. Let
it monitor for 30-40 min.

- Stop the measurements by clicking Measurement button on the front panel and Yes
(Measurement = S3). The Monitor is now ready for the calibration.

6.2. Calibration
6.2.1. General settings

Before the calibration will be set-up in the Monitor it is advisable to check the information
about units and filters.

Check the units, by clicking Set-Up on the front panel, Configuration branch and Unit part
(Set-Up >S3 >S1). Investigate the units following the diagram presented on Figure 35.

Check the information about filters, by clicking Set-Up on the front panel, Configuration
branch and Filters part (Set-Up —>S3 —>S3). Investigate the information for the filters
following the diagram presented on Figure 35. If you are only recalibrating the Monitor for
the same filter positions and banks, then the names of the gases will be probably correct. If
you are calibrating a new gas or an existing gas in a new filter bank, then the name of the gas
and the molecular weight need to be typed in. Before changing these information contact
person responsible for the Monitor.
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6.2.2. Setting-up a calibration task

The description of different types of calibration tasks can be found in sections 4.3 Zero point
(N2), 4.4 Humidity calibration (H20) and 4.5 Gas span calibration. Here only practical
information about setting-up different calibration tasks in Briiel & Kjcer 1302 Monitor will be
given. Below on Figure 36 can be found a general schematic diagram showing the calibration
task Set-up “Tree”. When setting-up a calibration task in the Monitor you should follow the
black arrows according to the type of calibration you want to perform. Exemplary schematic
diagram showing how to set-up a combined cross-interference and span calibration task is
shown on Figure 37. Additional schemes, if needed, can be found in Instruction Manual (7) in
chapter 16 Calibration of the optical filters.

1" 'PERFORM ZERO-POINT CALIBRATION?

(using dry, zero gas) '
_'PERFORM HUM. INTERFERENCE CALIBRATION?
A NOSE we o B s OYES

(using wet, zero gas) ‘

If only ONE filter ("A"/"B"/"D"/"E") is installed in the carousel this

disﬁlax does not aaﬁear in the calibration set-ug

PERFORM' CROSS-INTERFERENCE CALIBRATION? All installed filters ("A" to "E") will be calibrated for cross
LEHEE { YES interference from the other span gases used during span
o - YES calibration

YES All installed filters ("A" to "E") will be zero-point calibrated

All installed filters ("A" to "E") will be calibrated for
interference from water vapour

(using span gases of known concentration)

PERFORM GAS SPAN CALIBRATION? -

CALIBRATE A WITH: (gas name appears here)
FIFNOT g b L e R YES YES NO

“NO- " " SINGLE-POINT ~ TWO-POINT

(using span gas of known concentration)

ENTER LOW GAS CONC.------ mg/m®
— — m—— n DOWN ¢ UAGCERT T UP
7 7ENTER GAS | CONC.----+- mg/m?, ' : .
" DOWN i 'ACCEPT up . ;
— ' ‘ ENTER HIGH GAS CONC.------ mgm
_DOWN' - 'ACCEPT up

' This display ONLY appears if you have selected to perform

zero- point calibration of filters installed in positions "A" to "E"

. CALIBRATE WATERVAPOUR FILTER? '
‘- NO ‘ Pl O YES T

" PERFORM WATER VAPOUR ZERO-POINT CALIB.?
UANG L Ll vEs

(using perfectly dry, zero gas)

- PERFORM WATER VAPOUR SPAN CALIBRATION? |

SUULUNG, T T YES
. — . — I — *VENTER “WATER-VAPOUR ‘CONC.: -~ - Tdew
PERFORM ‘- PRACTICAL: N’ TASK? e 2y ' IR
PRACUICAL. CALIBRATION. TAKY L ACCEPT up
. NO ST YES . < x Lt
— — — - (using zero gas containing an accurately know concentration
of water vapour)

Figure 36. Schematic diagram showing the general calibration task Set-up
“Tree”. (7)
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"PERFORM ZERO-POINT CALIBRATION?
NO- YES

. PERFORM . HUM. INTERFERENCE CALIBRATION?
© N0 YES

(using dry, zero gas)

(using wet, zero gas)

If only ONE filter ("A"/"B"/"D"/"E") is installed in the carousel
display does not appear in the calibration set-up

“PERFORM 'CROSS-INTERFERENCE CALIBRATION?
NO YES

(using span gases of known concentration)

£ . e TR . - 5
PERFORM :GAS. SPAN: CALIBRATION? °
NO A : YES

(using span gas of known concentration)

this

EITHER

LTER?
“~YES

 CALIBRATE WATER VAPOUR..FI
V:VNOI L f g

End of the set-up section of the calibration task
" 'PERFORM ' PRACTICAL  CALIBRATION - TASK?
- NO, YES

¥

CALIBRATE A WITH; (gas name appears here)
NO SINGLE-POINT - TWO-POINT

. ENTER'LOW GAS .CONG.------

DOWN - ACCEPT upP
ENTER HIGH GAS CONC.------
DOWN . : . .ACCEPT up

This display ONLY appears if you have selected to perform
zero- point calibration of filters installed in positions "A" to "E"
.. PERFORM WATER VAPOUR ZERO-POI

NT CALIB.? |
" No’ :

YES

(using perfectly dry, zero gas)

PERFORM WATER VAPOUR SPAN CALIBRATION?

NO YES
 ENTER WATER-VAPOUR CONC.------ Tdew
DOWN - '

ACCEPT

(using zero gas containing an accurately know concentration
of water vapour)

900165

Figure 37. Schematic diagram showing how to set-up a combined cross-
interference and span calibration task. (7)
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6.3. Performing calibration task and calculating calibration factors

Press Measurement button on the front panel of the Monitor.
Set-up a chosen calibration task, see section 6.2.2 Setting-up a calibration task.

When the calibration task settings are applied to the Monitor, a message about
connecting the proper gas to the Monitor will appear. When it is done press Enter
button.

Once the first measurement result is available it will appear on the screen and if the
printer is connected to the Monitor it will be automatically printed out on the
printer. Due to lack of space on the display only one result is shown, e.g. for the
zero-point calibration task the Monitor displays first only the signal measured by
the water-vapour filter and you cannot scroll through the measurements. On the
print-out however can be seen signals measured by all the installed filters.

The Monitor should continue measuring until the results are stable. It is easy to
track the results on the print-outs, however if the printer is not connected than it is
suggested to write the results down on a paper to be able to know when the values
have stabilised. When the measurement results are stable press Enter button. If
more than one signal is measured, all the signals for different filters have to be
stabilised and accepted by pressing the Enter button. The text “Calculating. Please
wait” will appear on the screen.

It should be noted that only last 6 measurements are stored in the Monitor during
any calibration. When 7 measurements have been performed, the first measurement
will be overwritten by the 7" measurement. That is why the Monitor only uses the
last 6 measurement results to calculate any calibration factor. If any calibration
factor is uncertain or unacceptable an error message will appear on the screen after
the calibration factors have been calculated and further information about the error
can be obtained by pressing Status button. Description of error messages can be
seen in Instruction Manual (7) chapter 18 Appendix 1 - Messages related to
calibration tasks.
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7. Measurements

In this chapter it is presented how to conduct exemplary measurements. The set-up of the
equipment, software used with computer, measuring procedure and collection of the data is
described. The Monitor can measure only one location at a time, so if it is planned to measure
in more locations simultaneously it is necessary to use a Multipoint Sampler and Doser. Each
of the Sampler and Doser can measure simultaneously in 6 locations, so two of them can
measure in 12 locations. With Gas Monitoring Software 7304 it is possible to use maximum
two Sampler and Dosers, but with other software it can be extended.

7.1. Set-up

In this section set-up of the equipment for measuring task is presented. This is based on one
Monitor and one Sampler and Doser, but it can easily be extended to two Sampler and Dosers.
The front and back panels of the Monitor and Sampler and Doser can be seen on Figure 39.
To prepare the equipment:

- Connect outlets from back panels, namely Outlet in the Monitor and Waste Air
Otlet in the Sampler and Doser, to external air by Teflon tubing.

- Connect Outlet to Analyser from back panel of the Sampler and Doser to Inlet Air
Filter located on the Monitor’s back panel by Teflon tubing.

- Connect the Monitor to the Sampler and Doser by [EEE-488, GPIB, cable
presented on Figure 40a.

- Connect the PC with installed software to the Monitor with a cable presented on
Figure 40b, COM port in the Computer and RS-232-C port in the Monitor.
Remember that special USB flash drive, see Figure 41a, with a key to the software
should be inserted to the Computer.

- Set a Device Address that is used to communicate with specific Sampler and Doser.
The switches are located on the back panel of the Sampler and Doser and can be
seen on Figure 41b. Normally number 15 can be used for first Sampler and Doser
and number 16 for second.

- Connect Teflon tubing used for sampling, maximum six tubes for one Sampler, to
the Sampler and Doser in the Sampler field, see Figure 39a.

- Plug both, the Monitor and the Sampler and Doser, to electric sockets.
- Turn on the Monitor and Sampler and Doser.
- Turn on the Computer.

- Turn on the Gas Monitoring Software 7304, see icon on Figure 38.

b Ly

Wiy

Figure 38. Gas Monitoring Software 7304 icon.
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Figure 39. The Monitor and Multipoint Sampler and Doser a) front panel and
b) back panel.

Figure 40. Cables used to connect a) the Monitor and the Multipoint Sampler and
Dosser and b) the Monitor and the Computer with software.

INNOVA
Prod. No. 7620
Serial No. 780-058

a) b)
Figure 41. Pictures presenting a) USB flash drive holding serial number and key

to the software and b) close-up on the Multipoint Sampler and Dosser’s back
panel with switches for Device Address with selected binary address number 15.

Page 36



7.2. Gas Monitoring Software 7304
7.2.1. Setting up measurements

When the software is ready to use a window shown on Figure 42a can be seen. In this section
measurements using Gas Monitoring Software 7304 are described.

e
File View Help

Dl 5 ¥ e 5]

Open...

Delete

Import

Export

Backup
Restore

Printer Setup...

Exit

For Help, press F1 NUM 4

a) b)

Figure 42. Picture showing a) starting window and b) creating new file.

- A New Calibration Task @ can be created from File menu (File = New), see
Figure 42b, and the name can be chosen, see Figure 43a,

- Or an old Calibration Task can be Opened by selecting Open @ from File menu
(File > Open) and the file can be chosen from the list, see Figure 43b.

- When ready click OK. The next steps should be proceeded only for the new file.

Cancel

Figure 43. Pictures presenting windows a) New Database and b) Open Database.
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A new menus should be available, namely Edit, Set-up and Measurement.

Select Set-up menu and click on Configuration (Set-up > Configuration), see
Figure 44a. Select type of communication with the Computer and number of used
Sampler and Dosers in Connected Multiplexers field, see Figure 44b. Click OK

p

L’;’: Innova AirTech Instruments - Type 7620 [Monitor

File Edit Measurement View Help
Configuration

| Communication

Monitor

Multiplexer

Units

Alarms

User Program

Font

a)

rSystem Configuration
Communication Interface
(" |EEE f(» COM1 ¢ COM2
(" COM3 ( COM4
(" COM5 ¢ COMB

Connected Multiplexers
v 1303(1) ¥ 1303(2)

-

s

Help

0K

Cancel

i

b)

Figure 44. Pictures presenting a) Configuration menu b) Configuration window.

Select Set-up menu and click on Communication (Set-up > Communication), see
Figure 45a. Select type of communication with the Monitor and Sampler and
Dosers. Choose Monitor communication according to information shown on Figure
19 or Figure 45b. Green dots represent configuration for Innova 1412
Photoacoustic Field Gas-Monitor, and orange dots represent configuration for
Briiel & Kjer 1302 Photoacoustic Gas-Monitor. Choose the values carefully
depending on the used Monitor. Select Devices Address for the Monitor to 14 and
for Sampler and Dosers respectively to Set-up, normally 15 for the first and 16 for
the second, see Figure 45b. Click OK.

P

L':’: Innova AirTech Instruments - Type 7620 [Monitc

File Edit Measurement View Help

i Configuration
[ Communication
Monitor
Multiplexer
Units
Alarms
User Program

Font

a)

Communication @
Selected Communication:  COM1 Help
Baud Rate Data Bits
(300 ¢ B00 (1200 -
(2400 4800 [+ 9800 O
® -
Parity Stop Bits
 None { Odd s Even S 1 62
|IEEE Address
Gas-Monitor: |14 -
oK
1303 (1): 15 1303 (2): 16
Cancel

Figure 45. Pictures presenting a) Communication menu and b) Communication

window.
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Select Set-up menu and click on Monitor (Set-up => Monitor), see Figure 46a.
Click on Read button in Gas-Monitor Set-up window and wait until the information
from the Monitor is received, which means that the names of the gases should be
seen now, see Figure 46b. Select sampling interval, compensation type, choose
normalization temperature equal to 0 °C and correct air pressure. Finally choose the
filters that should measure the concentration. Click OK.

p

Dl |

L"_’: Innova AirTech Instruments - Type 7620 [Monito

File Edit Measurement View Help

Configuration
Communication
Monitor
Multiplexer
Units

Alarms

User Program

Font

Gas-Monitor Set-up
Compensation

v \Water Compensation

IV Cross Compensation

Normalization Temperature
0,00 °C

Filters

Sample information
" Sample Continuously
" Sequence Interval:
]_5 min
Air Pressure
101,30 kPa

a)

© AfCabondoids
© B[Dmogenonde
-
o]
e

vV W:Water Vapour

. 44,01
. 44,01
. 0,00
. 0,00
. 0,00
. 18.02

s

Help

Read

Advanced Setup

K

il

Cancel

b)

Figure 46. Pictures presenting a) Monitor menu and b) Gas-Monitor Set-up

window.

Select Set-up menu and click on Multiplexer (Set-up > Multiplexer), see Figure
47a. In Multiplexer Set-up window select Sample Channels for Sampler and Dosers
that should be used for measurements, see Figure 47b. Click OK.

l.f;’: Innova AirTech Instruments - Type 7620 [Monitc

File Edit Measurement View Help

Dlw| |

Configuration
Communication
Monitor
Multiplexer
Units

Alarms

User Program

Font

1 | 2

Multiplexer Set-up

I+ |5 s

Sample Channel Information
[V Channel Active

Location: |

Aam

™ Gas-Monitor Relay 1 [~ Gas-Monitor Relay 2

™ Gas-Monitor Beeper | PC Speaker

a)

X

Active Channels

il I

<l <l

<l <l
@ oo s w N
E B E =

<l

o]

Cancel I

Help

b)

Figure 47. Pictures presenting a) Multiplexer menu and b) Multiplexer Set-up

window.

Finally select Set-up menu and click on Units (Set-up = Units), see Figure 48a. It
is advised to check units which are used. Examine the Units window that is
displayed, see Figure 48b. Gas concentration can be selected to parts per million
(ppm) and water vapour concentration to absolute humidity (mg/m?). Click OK.

Now the software is ready to use for measuring gas concentration.
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Configuration
Communication
Monitor
Multiplexer
Units

Alarms

User Program
Font

a)

Figure 48. Pictures presenting a) Communication menu and b) Communication
window.

7.2.2. Starting and stopping measurements

- To start the measurements select Measurement menu and click on Start
(Measurement = Start), see Figure 49a.

- You can see the measurements in Graphic Window. Select View menu and click on
Graphic Window (View > Graphic Window), see Figure 49b. The Graphic
Window should appear on the screen, see Figure 50. On the left side of the window
there are buttons for setting up the graph, namely Graph Setup and Data Select.

Measureme «: Help —
2[%2| B||| v Toolbar
'V StatusBar

} Numeric Window i

Graphic Window

Status Window

Notepad Window
v | Show Panel

Show Values

Comments
View Warning/Error/Status Flags

b)

Figure 49. Pictures presenting Pictures presenting a) Start menu and b) Numeric
Window menu.
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I le Edit Set-up Measurement View Help

D slewe =
Granh C  Measurement Line Scale Unit C  Measurement Line Scale Unit
S:Sp 1 Dinitrogen oxide —— 1 ppm 2 Dinitrogen oxide —— 1 ppm
3 Dinitrogen oxide 1 ppm 4 Dinitrogen oxide —— 1 ppm
Data | Dinitrogen oxide —— 1 ppm 6 Dinitrogen oxide —— 1 ppm
Select | 100, 00
90,00+
Key
0.0
70,007
Cursor
i 60,007
50,007
Cursor 40,00+
Zaii 30, 00
Data 20,007
Edit 10,007
0,00 T T T T T T T T T T T T
E“D 2013-,02-15 2013-02-15 2013-02-/15  2013-,02/15 2013-/02-/15
i) 15:10 15:40 16:10 16:40 17:10
For Help, press F1 NUM 4

Figure 50. Graphic Window.

To set up the axes of the graph click on Graph Setup button. In Graph Parameters
window scale and range of the axes can be changed. To change the time span that
is shown change values in X-interval square, see Figure 51a.

To set up channels, lines’ type and color, filters and shown values click on Data
Select. In Select data to show on graph window, see Figure 51b, you can switch on
and off the channels by double click on them and edit them clicking on channel and
changing the values. Additional information can be found in Channel Data
window, see Figure 51b,which can be accesed by Data button.

B8]
4 Dinitragen oxide - M
5 Dinitrogen oxide : I:S)cnliril1 -~ ‘ “
> B Dinitrogen oxide as D

) Chan () Use (| Mez ’

Dot
Dash Dot &2

Figure 51. Picture presenting a) Graph Parameters window and b) Select data to
show on graph and Channel Data window.

To stop measurments select Measurement menu and click on Stop (Measurement
- Stop), see Figure 49a.
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7.2.3. Collecting data

Data can be copied from Numerical Window. Select View menu and click on
Numeric Window (View = Numericic Window), see Figure 49b.

Numeric Window presents time and concentration in two columns, see Figure 52.
The data can be copied from the window or printed to PDF file and then transferred
to other computers.

(25 Numeric Window ‘E@

e SETTINGS cenerAL *
Graph ArTazn Sezuence mane 005 S |
S elup fsTUmeTS Sampie Cycie 5253 Swo |
Tyo= 7820 Normalized Temp. 00°C Comgoress|
Cross Compensaton Yes ‘Weming: |
D t Ges ‘Waner Vapour Compens: Yes Das Eo i
ata Moamceng A Pressure 101.30kPs Piot Resol| _
Select [=
Nexl Channal 1, Dinfrogen cxide, Alarm Bmiz: Nooe
Curve e Temperstare Wemings/Enors |
foom] ra 7620 Monnor —
Previous 15022013 17:18:11 943 Nooe
170325 1045 Nooe
Curve 17:00:41 1085  Nome
165158 1005 Nome
184311 1009 Nome
Enable 153428 1052 Nome
Scroll 182541 1077 Nome
161658 1035  Nome
180811 1173 Nome
155925 1239 Nome
15:50:41 1221 Nooe
154138 1664  Nooe
153311 1552 Nooe
152428 1372 Nome
N — e
< | 1] | »

Figure 52. Picture showing Numeric Window
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